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ABSTRACT

The project aims to evaluate the performance of the variable speed horizontal axis
wind turbine, through software and practical approach methods. A wind turbine is a
device that converts the freely available kinetic energy in the wind to the electrical
power. This project describes about the construction principles which help in
improving the efficiency of the wind turbine, as they are becoming more popular in

the modern renewable energy world. Primary objective is to design the wind turbine
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blades and the tower for the turbine which plays a major role in efficiency and
further efficiency of turbine is increased by using sensors systems and their
functioning, and by using wind lenses the principles of these systems are described.
The design of the blade is done in software called Q-BLADE and power output is also
determined from this software which uses Blade Elemental Theory. And tower for
wind turbine is designed in CATIA software. Construction of the wind turbine is done
and power is evaluated for the turbine and then by using practical approach
methods which make changes in aerodynamic parameters on the turbine blades the
obtained efficiency is increased and evaluated.

Keywords: Wind lens, HAWT, CATIA, CFD, Propeller etc.,©KY Publications

INTRODUCTION people believe that the windmill and wind turbine

Wind is a form of solar energy and is a
result of the uneven heating of the atmosphere by
the sun, the irregularities of the earth's surface, and
the rotation of the earth. Wind is the movement of
air from an area of high pressure to an area of low
pressure. Humans use this wind flow, or motion
energy, for many purposes: sailing, flying a kite, and
even generating electricity. In fact, Ancient mariners
used sails to capture the wind and explore the
world. Farmers use windmills to grind their grains
and pump water. Today, more and more people are
using wind turbines to wring electricity from the
breeze. Over the past decade, wind turbine use has
increased at more than 25 percent a year. Many

are the same thing. They are actually very unique
and different in many ways. The wind turbine was
made to produce energy for a clean and safe
environment.

Fig 1.11 Wind Turbines in ANDHRA PRADESH, INDIA
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1.2 How Does Wind Turbines Make Electricity

The terms wind energy or wind power
describes the process by which the wind is used to
generate mechanical power or electricity. Wind
turbines convert the kinetic energy in the wind into
mechanical power. This mechanical power can be
used for specific tasks (such as grinding grain or
pumping water) or a generator can convert this
mechanical power into electricity. A wind turbine
works the opposite of a fan. Instead of using
electricity to make wind, like a fan, wind turbines
use wind to make electricity.

A wind turbine is a device that converts
kinetic energy from the wind into electrical power.
Wind turbines operate on a simple principle. The
energy in the wind turns two or three propeller-like
blades around a rotor. The rotor is connected to the
main shaft, which spins a generator to create
electricity.

A quantitative measure of the wind energy
available at any location is called the Wind Power
Density (WPD). It is a calculation of the mean annual
power available per square meter of swept area of a
turbine. The wind power density, measured in watts
per square meter, indicates how much energy is
available at the site for conversion by a wind
turbine.

The major types of wind power are:

e  Utility-scale wind, wind turbines larger than
100 kilowatts are developed with electricity
delivered to the power grid and distributed to
the end user by electric utilities or power
system operators.

e Distributed or "small" wind, which uses turbines
of 100 kilowatts or smaller to directly power a
home, farm or small business as it primary use.

e Offshore wind, which are wind turbines erected
in bodies of water around the world.

Most modern wind turbines have three blades. A

number of variations have been tried, two blades,

even one blade — but three blades works the best.

Modern wind turbines rotate anti clock wise.

7. HIGH-SPEED SHAFT:
Wind turbine Atiaches to the generator.
components
1. ROTOR: The rotor is made
up of biades affixed to a hub

8. GENERATOR: Converts the
m energy by th

as 1
Jength of a football field.
2. PITCH DRIVE: Blades can be rotated 10
reduce the amount of it when wind speeds.
become too great

3. NACELLE: The rotor attaches 1o the nacelle,
‘which sits atop the tower and eacloses the
various components

: A mechanical brake acts as a
0 the braking effects of he biade

backup
pitch drives or as a parking brake for
maintenance.

Fig 1.2.1 Parts of Wind Turbine

1.3 Advantages of Wind Turbine

e  Wind is the cheapest form of renewable energy.

e Wind turbine blade rotates 15-20rpm to
generate electricity.

e [t spins 70-80% of the time producing power.

e A wind turbine produces power which is equal
to power produce by 16000 solar panels.

e Energy is used in constructing wind turbine, but
the turbine generates equivalent energy within
6 months and it keeps on generating energy.

e Modern wind turbines are extremely quiet and
they are pollution free.

7\ -3 Blade Rotor

Wind

5 Lights

Radio

Fig 1.2.2 Functioning Of Wind Turbine
LITERATURE SURVEY
2.1 BETZ’S LAW:Betz's law calculates the maximum
power that can be extracted from the wind,
independent of the design of a wind turbine in open
flow. It was published in 1919, by the German
physicist Albert Betz. The law is derived from the
principles of conservation of mass and momentum
of the air stream flowing through an idealized
"actuator disk" that extracts energy from the wind
stream. According to Betz's law, no turbine can

459 K.P.PREETHI MANOHARI SAl et al.,


http://en.wikipedia.org/wiki/Wind#Wind_power_density
http://en.wikipedia.org/wiki/Wind#Wind_power_density
http://en.wikipedia.org/wiki/Wind#Wind_power_density
http://www.daviddarling.info/encyclopedia/W/AE_wind_turbine.html
http://www.awea.org/Issues/Content.aspx?ItemNumber=4592
http://www.awea.org/Issues/Content.aspx?ItemNumber=822

International Journal of Engineering Research-Online
A Peer Reviewed International Journal
Email:editorijoer@gmail.com http://www.ijoer.in

Vol.4., Issue.3., 2016

(May-June)

capture more than 16/27 (59.3%) of the kinetic
energy in wind. The factor 16/27 (0.593) is known as
Betz's coefficient. Practical utility-scale wind
turbines achieve at peak 75% to 80% of the Betz
limit.
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Fig 2.1.1 efficiency of wind turbine
The Betz limit is based on an open disk actuator; if
a diffuser is used to collect additional wind flow and
direct it through the turbine, more energy can be

extracted.
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Fig 2.1.2 Betz law pictorial representation for
turbine

Betz' Law applies to all Newtonian fluids,
but here wind is used as an example. Consider that if
all of the energy coming from wind movement
through a turbine was extracted as useful energy
the wind speed afterwards would drop to zero. If
the wind stopped moving at the exit of the turbine,
then no more fresh wind could get in - it would be
blocked. In order to keeps the wind moving through
the turbine there has to be some wind movement,
however small, on the other side with a wind speed
greater than zero. Betz' law shows that as air flows
through a certain area, and when it slows from
losing energy to extraction from a turbine, it must
spread out to a wider area. As a result geometry
limits any turbine efficiency to 59.3%.
2.2 Types Of Wind Turbines

Wind turbines can be separated into two
basic types determined by which way the turbine

spins. The mechanism is same for the both wind
turbines but only the direction changes. Wind
turbines that rotate around a horizontal axis are
called as horizontal axis wind turbines(HAWT) and
are more common (like a wind mill), while the wind
turbines that rotate around a vertical axis are called
as vertical axis wind turbines(VAWT) and are less

frequent compared to HAWT.
2.3 Vertical Wind Turbine

Fig 2.3.1 Vertical Axis Wind Turbine

Vertical-axis wind turbines (VAWTSs) are a
type of wind turbine where the main rotor shaft is
set vertically and the main components are located
at the base of the turbine. The Savonius is a drag-
type VAWT, so it cannot rotate faster than the wind
speed. This means that the tip speed ratio is equal
to 1 or smaller, making this turbine not very suitable
for electricity generation. Moreover, the efficiency is
very low compared to other types, so it can be
employed for other uses, such as pumping water or
grinding grain. Much of the swept area of near the
ground, making the overall energy extraction less
effective due to lower wind speed at lower heights.
A VAWT does not need to be oriented into the wind
and the power transition mechanisms can be
mounted at ground level for easy access. The
Savonius can be used where reliability is more
important than efficiency: small application such as
deep-water buoys , most of the anemometers are
Savonius-type , used as advertising signs where the
rotation helps to draw attention. The Darrieus
turbine is composed of a vertical rotor and several
vertically-oriented blades. A small powered motor is
required to start its rotation, since it is not self-
starting. When it already has enough speed, the
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wind passing through the airfoils generate torque
and thus, the rotor is driven around by the wind.
The Darrieus turbine is then powered by the lift
forces produced by the airfoils. The blades allow the
turbine to reach speeds that are higher than the
actual speed of the wind, thus, this makes them
well-suited to electricity generation when there is a
turbulent wind.

The blades of a VAWT rotate on a rotational
surface whose axis is at right angle to the wind
direction. The aerodynamic angle of attack of the
blades varies constantly during the rotation.
Moreover, one blade moves on the downwind side
of the other blade in the range of 180° to 360° of
rotational angle so that the wind speed in this area
is already reduced due to the energy extracted by
the upwind blades. Hence, power generation is less
in the downwind sector of rotation. Consideration of
the flow velocities and aerodynamic forces shows
that, nevertheless, a torque is produced in this way
which is caused by the lift forces. The breaking
torque of the drag forces in much lower, by
comparison.

2.4 Horizontal Wind Turbine

Fig 2.4.1 Horizontal Axis Wind Turbine
Horizontal axis wind turbines have been the

standard for years which are now gaining favour
with homeowners. Horizontal axis wind turbines, as
the name implies turn on a horizontal axis or axel.
The horizontal axis wind turbines (HAWT) need to be
pointed into the wind for optimal efficiency. When
the air flow acts on the blade, it generates two kind
of forces, named lift and drag, which are responsible
for the rotating of the blades.

The HAWT works when the wind passes
over both surfaces of the airfoil shaped blade as air
passes more rapidly at the upper side of the blade,

thus, creating a lower-pressure area above the
airfoil. The difference in the pressures of the top and
bottom surfaces results in an aerodynamic lift. The
blades of the wind turbine are constrained to move
in a plane with a hub at its center, thus, the lift force
causes rotation about the hub. In addition to the
lifting force, the drag force, which is perpendicular
to the lift force, impedes rotor rotation. There are
two kinds of Horizontal Axis Wind Turbines:
a. The upwind wind turbine
b. The downwind wind turbine

a) Upwind wind turbine:

Fig 2.4.2 Upwind Wind Turbine, HAWT
b) Downwind wind turbine:

Fig 2.4.3 Down Wind Turbine, HAWT
2.5 Basic Parts Of HAWT
The basic parts of a horizontal axis wind

turbine (HAWT) are foundation, tower, nacelle,
Generator, Rotor Blades.
TOWER:A tower that supports the nacelle and rotor
hub at its top. These are made from tubular steel,
concrete, or steel lattice. Height of the tower is an
important in design of HWAT. Because wind speed
increases with height, taller towers enable turbines
to capture more energy and generate more
electricity.
There are 2 types of towers:

» floating towers

» land-based towers.
Floating Wind Turbines:
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A floating wind turbine is an offshore wind
turbine mounted on a floating structure that allows
the turbine to generate electricity in water depths
where  bottom-mounted towers are not
feasible. Locating wind farms out at sea can
reduce visual pollution. whilst providing better
accommodation for fishing and shipping lanes. In
addition, the wind is typically more consistent and
stronger over the sea, due to the absence of

topographic features that disrupt wind flow.

Fig 2.5.1 floating tower
Land-Based
onshore wind turbine mounted on a foundation

Tower:A Land-Based Toweris an

structure that allows the turbine to

generate electricity.

Fig 2.5.2 land based tower
Most wind turbines start operating at a speed of 4-5

meters per second and reach maximum power at
about 15 meters per second. Wind turbines operate
on a simple principle. The energy in the wind turns
two or three propeller-like blades around a rotor.
The rotor is connected to the main shaft, which
spins a generator to create electricity. Wind turbines
are mounted on a tower to capture the most
energy. At 100 feet (30 meters) or more above
ground, they can take advantage of faster and less
turbulent wind.
The structural design of a wind turbine

consists of two main parts:

» Tower

»  Foundation.

The tower design is based primarily on wind
and ice loads, loads acting from the rotor, nacelle,
blades, and additional equipment at the top of the
tower in addition to wind loads acting on the tower.

The foundation is designed according to the
moment and axial loads resulting from the tower
design and the properties of the supporting soil.
Tower:The tower is designed to resist the loads
acting on it based on the desired scale of the wind
turbine and desired hub height. A taller tower
translates to an exponential increase in the amount
of wind that is being harvested from the wind
turbine because wind speed increases as the harvest
height increases. The “increase factor” of the wind
speed increases exponentially as the height above a
surface increases, as shown in Figure From this
graph, one can see that at low heights, the wind
speed increases significantly at first, but at higher
elevations the rate of increase is much less.

windspeed

Height above surface
=
=}

1 1‘.2 1;4 1‘6 1?6 é 2.‘2

Increase factor
Fig 2.5.3 tower height and wind factor graph

The wind speed will also vary due to the
surrounding area. The increase factor of wind
speeds is higher in open areas (such as over a body
of water) than in highly vegetated areas (such as
wooded or built- up areas). Through vyears of
experience, turbine manufacturers and consultants
have recommended that a turbine should be at least
30 feet higher than any object within 300 feet. This
rule of thumb is used to avoid rapid changes in wind
velocity and direction, or turbulence. The wind
speeds must be maximized and direction constant at
the blades of the turbine in order to maximize the
productivity of the wind turbine. A reduction in
turbulent winds also reduces the wear and fatigue
on the wind turbine.
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The most widely used design of a wind
turbine tower today is a freestanding, continuously
tapered, cylindrical hollow steel monopole. The
conical shape is efficient in simultaneously
increasing the tower strength and saving materials
as well as reducing the exposed profile for wind
forces at higher elevations. The tower is constructed
in sections from rolled steel at a desired thickness,
and is transported on site and bolted and/or welded
together to create the massive towers.

The design of a wind turbine tower is
dependent on the criteria outline in Table. The
codes used in conjunction with the design method
are also listed. It is the responsibility of the engineer
to design the wind turbine tower against local
buckling, bending and combined axial and bending
failures.

Tower Design Criteria

magnification factor on the
bending stress

Design Factor Design Criteria

Consists of the self weight of
Dead Load the

tower, the turbine
equipment at

the top of the tower, and ice
loads

Wind profile is
Wind Load approximated
along small sections of the

tower

Considers a column’s
Local Buckling slenderness

ration, resist failure due to
high

axial compressive loads

Foundation: The foundation of a wind turbine is
designed for the worst-case loading. The turbine
foundation has to resist great loads mainly because
of the overturning moment due to wind and must
simultaneously resist forces from geotechnical
conditions. Reinforced concrete spread footings are
most common in design because they are applicable
to a wide range of soil strengths, however for some
weaker soils a deeper foundation is needed to
stabilize the turbine tower. The main components in
designing a spread footing are its width, depth,
amount of steel reinforcement, and construction
requirements.

Fig 2.5.4 Foundation for tower
The essential foundation design criteria are stiffness,
strength, stability, differential settlement, durability,
and economy. These minimum values for
foundations are usually provided by the turbine
manufacturers’ design specifications. Table below
lists the design factor, its design criteria, and any
design codes or standards that are used in
conjunction with the criteria.

Foundation Design Criteria

Design Factor Criteria

Resist failure due to high
Flexural Failure bending

moments inducing tensile
strength in a cross section
that is

greater than the yield

strength

Withstand factored
loads and fatigue loads

Strength

Stability Resist excessive
translational and
rotational
movement under

extreme loads

Considers the combined
Combined Axial and | failure

Bending loads due to combined axial and

bending loads with a

Settlement Considers soil criteria to
ensure adequate

bearing capacity

Durability Resist environmental

damage to concrete and
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maintain serviceability
for the turbine's
lifetime

Nacelle:A housing which contains all the
components which is essential to operate the
turbine efficiently is called a nacelle. It is fitted at
the top of a tower and includes the gear box, low-
and high-speed shafts, generator, controller, and
brakes. A wind speed anemometer and a wind vane
are mounted on the nacelle.

Blades:Wind turbine blades are used to extract the
kinetic energy of wind and convert to mechanical
energy. These blades are made up of fiber glass-
reinforced polyester or wood-epoxy. Wind turbines
have one or two or three or multiple blades based
up on the construction. Most of the HAWT have
three blades. These are connected to rotor hub.
Multiple blade concepts are used in earlier days for
pumping water and grinding etc

1) Single blade HAWT :It reduces the cost and
weight of the turbine. These are rarely used
due to tower shadow effects, needs
counter weights on the other side of the
blade, less stability.

2) Two blades HAWT: It requires more
complex design due to sustain of wind
shocks. It is also less stable. It saves the cost
and weight of one rotor blade.

Two- and one-bladed machines require a more
complex design with a hinged (teetering hub) rotor,
i.e. the rotor has to be able to tilt in order to avoid
too heavy shocks to the turbine when a rotor blade
passes the tower. The rotor is fitted onto a shaft
which is perpendicular to the main shaft, and which
rotates along with the main shaft. This arrangement
may require additional shock absorbers to prevent
the rotor blade from hitting the tower.

3) Three blades HAWT: Modern wind turbines
use three blade concept. Because this
structure have height strength to withstand
heavy wind storms. Less effect due to
tower shadow. Produces high output than
the four bladed wind turbine.

With more number of blades, blades should
be thinner to be aerodynamically efficient. But
blades with thinner portion at the root may not

withstand bending stress induced due to axial wind
load. So generally wind turbines with 3 blades which
can accommodate a thicker root cross-section are
used.

Fig 2.5.5 Single blade HAWT

Fig 2.5.7 Three blades HAWT
As the number of blades in the wind

turbine increases aerodynamic efficiency increases,
but in a diminishing manner. When we move from 2
blades to 3 blades design efficiency gain is about 3%.
The more blades there are on a wind turbine, the
higher will be the torque (the force that creates
rotation) and the slower the rotational speed
(because of the increased drag caused by wind flow
resistance). But as we move from 3 blades to 4
blades design, efficiency gain is marginal. As we
increase number of blades, cost of the system
increases drastically. Along with that mechanical
design of blades also becomes a difficult affair.
2.6 Principle Of Wind Turbine

A condition for an efficient conversion of
the wind energy into mechanical energy with wind
turbines is the optimal design of the rotor blades.
Methods for rapid development, reliable and robust
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predictions of the aerodynamics characteristics and
simulation of the flow conditions around a rotor
blade are essential for this design task.

The shape and dimensions of the blades of
the wind turbine are determined by the
aerodynamic performance required to efficiently
extract energy from the wind, and by the strength
required to resist the forces on the blade. The
rotation of the blades is due to the different in
pressure on the surface of the blade causes it to lift
as the blade is attached to the hub it revolves. To
design a blade different types of airfoils are used,
and the twist is different at different positions.

Blades play a part in the wind turbine
principle by combining with the pillar that goes
down to the generator. Every time they are
revolved, they impart some mechanical energy on
the middle part of the structure, which is shaped like
a rod with coils upon it. These turn anticlockwise to
the spin of the wing-like devices above in order to
impart this energy through friction to the generator
below. The latter is able to convert the sent waves
into power that can be stored in terms of volts.

The wind turbine principle also places
special importance to the mechanical friction in
order to automate the whole process and stem any
undue revolution during drastic changes in climate.
The central rods usually revolve anticlockwise to the
spin of the blades to pass on their generated force
to the next rod beyond the gear kit.

The latter, which is large and connects
directly to the generator, begins faster revolution.
While this is beneficial in increasing the potential
power generated, in certain cases if left unchecked,
especially in stormy conditions, it can break down.
To check on this, the machine comes with a set of
braking installations in both stages of the rods, to
break on any adverse speed. The central pillar also
can revolve on itself to face the whole structure
towards the current instead of down its direction in
order to stem on the velocity.

2.7 Working Of Wind Turbine

Transformer
Generator
Geartox’
]
s
Fig 2.7.1 Working Of HAWT
Rotor blades take the energy out of the
wind. They "capture" the wind and convert its
motive energy into the rotation of the hub. The
profile is similar to that of airplane wings. Rotor
blades utilize the same "lift" principle. A wind
turbine tower is not just a support structure. It
raises the wind turbine so that its blades safely clear
the ground and so it can reach the cleaner, stronger
winds at higher elevations. The hub directs the
energy from the rotor blades on to the generator. If
the wind turbines have a gearbox, the hub is
connected to the slowly rotating gearbox shaft,
converting the energy from the wind into rotation
energy. If the turbine has a direct drive, the hub
passes the energy directly on to the ring generator.
A gearbox is typically used in a wind turbine to
increase rotational speed from a low-speed rotor to
a higher speed electrical generator.
2.8 Design Of The Blade
The wind turbine blade is designed by using
different airfoils, the airfoils are used according to
the efficiency required and circular foil is used at the
root of the blade for the structure to be fixed in the
hub and for structural stability.

Fig 2.8.1 Internal Design Of The Blade

The blade section consists of the root,
primary and tip. At the root section circular foils are
used and then the airfoils are placed at a twist angle
with the root and it is continued till the tip section.
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The placing of different airfoils, the chord and the
position of the airfoils is required for designing.

The modern blade can be divided into three
main areas classified by aerodynamic and structural

J:/_/y oh (e ___:__:—_“1_

Radus (1)

function

f,._ Roat Mid spen — T
Fig 2.8.2 Parts Of Blade

The blade root : The transition between the circular
mount and the first aerofoil profile this section
carries the highest loads. Its low relative wind
velocity is due to the relatively small rotor radius.

The low wind velocity leads to reduced
aerodynamic lift leading to large chord lengths.
Therefore the blade profile becomes excessively
large at the rotor hub. The problem of low lift is
compounded by the need to use excessively thick
aerofoil sections to improve structural integrity at
this load intensive region. Therefore the root region
of the blade will typically consist of thick aerofoil
profiles with low aerodynamic efficiency.
The mid span: Aerodynamically significant the lift to
drag ratio will be maximised. Therefore utilising the
thinnest possible aerofoil section that structural
considerations will allow.
The tip: Aerodynamically critical the lift to drag ratio
will be maximised. Therefore using slender aerofoils
and specially designed tip geometries to reduce
noise and losses. Such tip geometries are as yet
unproven in the field, in any case they are still used
by some manufacturers.

Fig 2.8.3 Different Views Of Wind Turbine Blade

The aerodynamic design principles for a
modern wind turbine blade are detailed, including
blade plan shape/quantity, aerofoil selection and
optimal attack angles. A detailed review of design

loads on wind turbine blades is offered, describing
aerodynamic, gravitational, centrifugal, gyroscopic
and operational conditions. The orientation of the
shaft and rotational axis determines the first
classification of the wind turbine. A turbine with a
shaft mounted horizontally parallel to the ground is
known as a horizontal axis wind turbine or (HAWT).
A vertical axis wind turbine (VAWT) has its shaft
normal to the ground these two configurations have
instantly distinguishable rotor designs, each with its
own favourable.
2.9 Aerodynamics:Aerodynamic performance is
fundamental for efficient rotor design. Aerodynamic
lift is the force responsible for the power vyield
generated by the turbine and it is therefore essential
to maximise this force using appropriate design. A
resistant drag force which opposes the motion of
the blade is also generated by friction which must be
minimised. It is then apparent that an aerofoil
section with a high lift to drag ratio, be chosen for
rotor blade

The co-efficient for the lift and drag of
aerofoils is difficult to predict mathematically,
although freely available software, such as XFOIL
model results accurately with the exception of post
stall, excessive angles of attack and aerofoil
thickness conditions. Traditionally aerofoils are
tested experimentally with tables correlating lift and
drag at given angles of attack and Reynolds
numbers. Historically wind turbine aerofoil designs
have been borrowed from aircraft technologies with
similar Reynolds numbers and section thicknesses
suitable for conditions at the blade tip. However,
special considerations should be made for the
design of wind turbine specific aerofoil profiles due
to the differences in operating conditions and
mechanical loads.
Tip Speed Ratio:The tip speed ratio defined as the
relationship between rotor blade velocity and
relative wind velocity is the foremost design
parameter around which all other optimum rotor
dimensions are calculated.

Aspects such as efficiency, torque,
mechanical stress, aerodynamics and noise should
be considered in selecting the appropriate tip speed
. The efficiency of a turbine can be increased with
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higher tip speeds , although the increase is not
significant when considering some penalties such as
increased noise, aerodynamic and centrifugal stress
an increase in centrifugal and aerodynamic forces is
associated with higher tip speeds. The increased
forces signify that difficulties exist with maintaining
structural integrity and preventing blade failure. As
the tip speed increases the aerodynamics of the
blade design become increasingly critical. A blade
which is designed for high relative wind speeds
develops minimal torque at lower speeds. This
results in a higher cut in speed and difficulty self-
starting.
2.10 Blade Shape:An efficient rotor blade consists of
several aerofoil profiles blended at an angle of twist
terminating at a circular flange. It may also include
tip geometries for reducing losses. To facilitate
production, several simplifications maybe made:
e  Reducing the angle of twist.
e Linearization of the chord width.
e Reducing the number of differing aerofoil
profiles.

All manufacturing simplifications are
detrimental to rotor efficiency and should be well
justified. The
techniques

introduction of new moulding
and materials has allowed the
manufacture of increasingly complex blade shapes.
Leading wind turbine suppliers now include most
optimisation features such as angle of twist, variable
chord length and multiple aerofoil geometries.

2.11 Airfoils:The structural requirements of turbine
blades signify that aerofoils with a high thickness to
chord ratio be used in the root region. Such aerofoils
are rarely used in the aerospace industry. Thick
aerofoil sections generally have a lower lift to drag
ratio. Special consideration is therefore made for
increasing the lift of thick aerofoil sections for use in
wind turbine blade designs.

National Advisory Committee for
Aeronautics (NACA) four and five digit designs have
been used for early modern wind turbines. The
classification shows the geometric profile of a NACA
aerofoil where the 1st digit refers to maximum
chamber to chord ratio, 2nd digit is the camber

position in tenths of the chord and the 3rd & 4th

digits are the maximum thickness to chord ratio in
percent.

Angle of Twist:The lift generated by an aerofoil
section is a function of the angle of attack to the
inflowing airstream. The inflow angle of the air
stream is dependent on the rotational speed and
wind speed velocity at a specified radius. The angle
of twist required is dependent upon tip speed ratio
and desired aerofoil angle of attack. Generally the
aerofoil section at the hub is angled into the wind
due to the high ratio of wind speed to blade radial
velocity. In contrast the blade tip is likely to be
almost normal to the wind.

The total angle of twist in a blade maybe
reduced simplifying the blade shape to cut
manufacturing costs. However, this may force
aerofoils to operate at less than optimum angles of
attack where lift to drag ratio is reduced. Such
simplifications must be well justified considering the
overall loss in turbine performance.
6-series:An improvement over 1-series airfoils with
emphasis on maximizing laminar flow. The airfoil is
described using six digits in the following sequence:

The number "6" indicating the series.

NACA 65(3)-618

NACA 65(3)-618 airfoil

Max thickness 18% at 39.8% chord.

Max camber 3.3% at 50% chord

NACA 6303618

Fig 2.11.1 (a) NACA airfoil
5 is the 10 times the position of minimum pressure
as a fraction of chord (0.5 chord) although it is also
the position of maximum thickness.
3 is the intended span of lift coefficients that low
drag occurs over in tenths (CL plus or minus 0.3).
6 is the designed lift coefficient in tenths (CL = 0.6)
18 is the maximum thickness as a percent
Maximum thickness 18% at 50% chord

NACA 64A-010 10.0%

NACA 64A010 airfoil

Max thickness 10% at 40% chord.

467 K.P.PREETHI MANOHARI SAl et al.,



International Journal of Engineering Research-Online
A Peer Reviewed International Journal
Email:editorijoer@gmail.com http://www.ijoer.in

Vol.4., Issue.3., 2016

(May-June)

Max camber 0% at 0% chord

Fig 2.11.1 (b) NACA Airfoil
The emergence of wind turbine specific
aerofoils such as the Delft University, LS, SERI-NREL
and FFA and RISO
specifically tailored to the needs of the wind turbine

now provide alternatives

industry.
S-Series:NREL's S-Series airfoils come in thin and
thick families.  The thin airfoil families lend
themselves to stall regulated wind turbines where
performance losses to airfoil soiling are significant.
For variable-pitch and variable-speed turbines,
airfoil soiling is not a major problem. Generally, a
primary airfoil is grouped with root and tip airfoils.
Most wind turbine blades have a circular section
that attaches to the hub.

important for pitching blades.

This is especially

There is then a
transition from the circular section to the root airfoil
section, which usually occurs around the maximum
chord. Between the circular section and the root
airfoil section, the transition is faired. The fairing
process should avoid concavities to prevent
buckling. The primary airfoil usually occurs in its
pure state around the 75% radius and the tip airfoil
is usually pure around the 95% location. Various
interpolation methods are used to define airfoil
The tip
airfoil is also usually retained out to the tip of the

shapes between the three pure airfoils.

blade, but some allowances can be made to
accommodate special tip shapes. The root airfoil
usually has the greatest thickness ratio (maximum
thickness to chord ratio) and the thickness ratio gets
smaller as one approaches the tip. At the blade
root, large airfoil thickness is needed to
accommodate blade structural considerations and
toward the tip thinner airfoils are needed to

minimize drag and blade soiling losses.

SE15 Ajrfail

|

SE11 Adrfoil

e

Fig 2.9.2 S-Series airfoil

The angle of attack is the angle of the
oncoming flow relative to the chord line, and all
figures for CL and CD are quoted relative to this
angle. The use of a single aerofoil for the entire
blade length would result in inefficient design. Each
section of the blade has a differing relative air
velocity and structural requirement and therefore
should have its aerofoil section tailored accordingly.
At the root, the blade sections have large minimum
thickness which is essential for the intensive loads
carried resulting in thick profiles. Approaching the
tip blades blend into thinner sections with reduced
load, higher linear velocity and increasingly critical
aerodynamic performance. The differing aerofoil
requirements relative to the blade region are
apparent when considering airflow velocities and
structural loads

An aerodynamic phenomenon known as
stall should be considered carefully in turbine blade
design. Stall typically occurs at large angles of attack
depending on the aerofoil design. The boundary
layer separates at the tip rather than further down
the aerofoil causing a wake to flow over the upper
surface drastically reducing lift and increasing drag
forces

The sensitivity of blades to soiling, off
design conditions including stall and thick cross
sections for structural purposes are the main driving
forces for the development of wind turbine specific
aerofoil profiles. The use of modern materials with
superior mechanical properties may allow for
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thinner structural sections with increased lift to drag
ratios at root sections. Thinner sections also offer a
chance to increase efficiency through reducing drag.
Higher lift coefficients of thinner aerofoil sections
will in turn lead to reduced chord lengths reducing
material usage

2.12 WIND LENS:A wind lens is a modification made
to a wind turbine to make it a more efficient way to
capture wind energy. The modification is a ring
structure called a "brim" or "wind lens" which
surrounds the blades, diverting air away from the
behind the blades. The
result of the new

exhaust  outflow
turbulence created as a
configuration creates a low pressure zone behind
the turbine, causing greater wind to pass through
the turbine, and this, in turn, increases blade

rotation and energy output.

Fig 2.12.1 wind lens structure

Wind power is proportional to the wind speed
cubed. If we can increase the wind speed with some
mechanism by utilizing the fluid dynamic nature
around a structure, namely if we can capture and
concentrate the wind energy locally, the output
power of a wind turbine can be increased
substantially. So a new efficient wind power turbine
system has been developed. This system has a
diffuser shroud at the circumference of its rotor to
embody the wind energy concentration. The shroud
is named as "Wind lens".

Fig 2.12.2 wind lens turbines
3. METHODOLOGY

3.1 Design Of The Blade; The design of the blade
and wind lens is done using different software :
» Q-BLADE
> CATIA
The blade is created in the Q-Blade software
and further modelling of wind lens is done in the
CATIA and analysis of the wind lens is done in CFD
fluent.
-3.2 Q-BLADE
e The designing of the blade is done in
software called QBLADE. It is an open
source wind turbine designing software.
The software is seamlessly integrated into
XFOIL, an airfoil design and analysis tool.
The purpose of this software is the design
and aerodynamic simulation of wind
turbine  blades.
performance data to a range of 360°Angle
of attack, and directly integrate them into

Extrapolations  the

a wind turbine rotor simulation.

Fig 3.2.1 Qblade Logo

e The blade design method for the wind
turbine, originates from the aircraft design
industry and apply the same techniques.
But the flow conditions that a turbine
blade experiences are quite different from
those affecting a plane

e The designing of the blade requires the
airfoil date, coordinates of the airfoils to
import, twist of the blade, positioning of
the airfoils and the circular foil parameters
used as root for the blade.

e The start screen of the software shows us
the main tool bars and the functionalities of
the tools, then by using the Foils the airfoils
required for designing the blade of the
turbine are imported by using a “.dat”
format file, now the imported airfoils are
analyzed in the X Foil tool. The analysis will
only converge for a limited range of angle
of attack values so they are given in the
menu bar and the analysis is done.
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e To simulate a wind turbine, the Angle of
attack range of the polar needs to be
extrapolated to 360degrees, this is done in
the polar extrapolation module. Only
extrapolated polar data can be used to
simulate a turbine or rotor.

e By using the rotor blade design in the main
tool bar the design of the blade is started
the positions of the airfoils and the twist in
the blades are given as the input for design.
The geometric blade data (chord, radial
position, twist, offset etc.) of the specified
blade sections and the associated foils and
360-polars. It is defined by a name. If a
blade object is deleted, all associated
simulations and turbines are deleted as
well.

e The blade is created by using specifications
and then Blade Element Momentum Blade
Element Momentum (BEM) method are
used to predict the efficiency of Horizontal
Axis Wind Turbines (HAWT) in the industry.

The functionality of the BEM software includes

the following features:

e  Extrapolation of XFOIL generated or imported
polar data to 360 — Angle of attack

e Advanced blade design and optimization,

including 3D  visualization, using XFOIL
generated or imported profiles

e Wind turbine definition (rotor blade, turbine
control, generator type, losses)

e  Computation of wind turbine performance over
wind speed range

e export functionality for all created simulation
data

e blade geometry export in .stl format

To design a blade in Q-blade we require
»  The airfoil data.

Coordinates of the airfoils to import.

Twist of the blade.

Positioning of the airfoils and

YV V V VY

The circular foil parameters used as root
for the blade.
Q-blade design:

» From the setup open the Q-blade start
screen.

Fig 3.2.2 Start Screen Of Q blade

» From the tool menu available on the
screen, press the Airfoil Design button (first
red button) and then import the airfoils
which are required for designing.

» NACA airfoils are inbuilt they can be used
directly from the software to import other
foils it can be done if the airfoil data file is
in ‘.dat’ format.

» The scale and chamber of the airfoils can
also be adjusted.

Fig 3.2.3 Airfoil Data
The S-Series airfoils are S815 and S811 are
selected, as these airfoils produce more lift. NACA
64A-010 and NACA 653-618 airfoils with less
thickness are also selected for the tip selection of
the blade. Circular foils are also used at the tip of
the blade so that the blade can be fixed in the hub.
> press the XFOIL Direct Design button
(second red button)
click Analysis > Define an Analysis such as
the Reynolds number, angle of attack of the
blade with the increment. Then analyse
each airfoil.
X-Foil analysis is performed on the airfoils and the CL
and alpha graphs are obtained.

360 EXTRA POLATION:
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1. press the Polar Extrapolation to 360 button
(360 button)

2. select the Montgomery radio button and
press Create New 360 Polar

3. configure the initial polar via the CD90
value, the A_ and B_ sliders and press Save
360 Polar

4. click 360 Polar > Generate a Circular Foil

Fig 3.2.4 360 Extrapolation Graph
The blade cl and cd is calculated for all the
360 degrees of rotation of the blade and the data is
obtained in a single graph. And this graph can be
changed so that the design of the blade is modified
with required efficiency
1. pressthe HAWT Rotor blade Design button (first
blue button)
press New Blade
3. Enter the blade data using the Scale, Optimize
and Advanced Design options and save

Fig 3.2.5 Design Of Blade
Design table:

Position Chord(m) | Twist Air foil
(m)

0 3.2 13.08 | Circular foil 1
1.36 3.54 13.08 | Circular foil 1
4.1 3.85 13.08 | Circular foil 1
6.83 4.167 13.08 | Circular foil 2

(May-June)
10.25 4.55 13.08 | DU99W405LM
14.35 4.652 11.48 | DU99W350LM
18.45 4.458 10.16 | DU99W350LM
22.55 4.2489 9.011 | DU97W300LM
26.65 4.007 7.795 | DU91W250LM
30.75 3.748 6.544 | DU91W250LM
34.85 3.502 5.361 | DU93W210LM
38.95 3.256 4.188 | DU93W210LM
43.05 3.01 3.125 | NACA64618
47.15 2.764 2.319 | NACA64618
51.25 2.518 1.526 | NACA64618
54.67 2.313 0.863 | NACA64618
57.4 2.086 0.37 | NACA64618
60.12 1.4 0.16 NACA64618
61.5 0.7 0 NACA64618

The different airfoils are used to generate various
lifts at given twist. To generate the maximum power
they are placed at different positions and chords.
The airfoils at the tip have less twist when compared
to the airfoils from the root since they have to
generate more lift. It is considered by the analysis in
CL vs a graph. When the air flow on the airfoil this
twist is sufficient to lift the blade.

Fig 3.2.7 3D Rotor Design
As the three blades are of same design, so it is easy
to create 3D blade. Then power simulation is
performed on the rotor blade.

» Press the rotor BEM simulation and define
rotor simulation. Enter the simulation
parameters tip speed, and start the
analysis, observe the extracted graphs.
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Fig 3.2.8 BEM Simulation Graphs
» Then define the parameters in the multi
parameter BEM simulation and then
analysis it.
> Press the turbine blade simulation and give
the input wind speed and output wind
speed and calculate the power generated

by the wind turbine blade.

» Thus the blades are designed with different
specifications and by verifying the power
available the blade design is selected for
further modelling.

» The selected blade can be exported from
the Q-blade, this is an .STL file.

33 CATIA:CATIA (Computer  Aided
dimensional Interactive Application) is the leading
product development solution for all manufacturing

Three-

organizations and is a
CAD/CAM/CAE commercial software
suite developed by the French company Dassault

multi-platform

Systems.

Fig 3.3.1 Catia Logo

CATIA enables the creation of 3D parts,
from 3D sketches, sheet metal, composites, forged
or tooling parts up to the definition of mechanical
assemblies. The software provides advanced
technologies for mechanical surfacing. It provides
tools to complete product definition, including
functional tolerances as well
as kinematics definition.

CATIA offers a solution to shape design,
styling, surfacing workflow and visualization to
create, modify, and validate complex innovative
shapes from industrial design to surfacing with the
ICEM surfacing technologies. CATIA is able to read
and produce STEP format files and IGES format files
and many other file formats.

The range of CATIA capabilities allows it to
be applied in a wide variety of industries, such as
aerospace, automotive, industrial machinery,
electrical, electronics, shipbuilding, plant design, and
consumer goods, including design for such diverse
products as jewelry and clothing. Various
workbenches in CATIA with surface creation tools
are:

1. Wireframe and Surface Design.
2. Generative Shape Design.

3. Part design

4. Assembly design

By using Catia windlen’s structure and
tower is designed with the different dimensions to

observe the flow properties in the structure

]

v
o
o

IR, BB P RREBRISBD0EE Ot e - @ XL

Fig 3.3.2 Catia Start Screen

472 K.P.PREETHI MANOHARI SAl et al.,



International Journal of Engineering Research-Online

A Peer Reviewed International Journal
Email:editorijoer@gmail.com http://www.ijoer.in

Vol.4., Issue.3., 2016

(May-June)

3.4 DESIGN OF TOWER:The tower is the fixed
support for the wind turbine which resists the loads
of the nacelle, hub and the blades and also resists
the moment force with the help of foundation.

The tower design is designed by using the
part design in catia and the steps involved in
designing are:

» The plane is selected for designing in
sketcher.

» By using the circle command in the profile
tool bar a circle is drawn as the base for the
tower.

» Then the plane command is selected and
offset is given to the plane in the parallel
direction to a maximum length.

» Then the plane is selected and sketcher is
used to draw the design from profile tool
bar circle command is used and other circle
is drawn with a diameter less than the
base.

» Then the design is moved to part design
and by using multi section solid in the
selection sketch tool bar the body is joined.

» Thus the tower is designed and the same
procedure is repeated for designing other
tower designs with change in the diameters
of base and other end.

a A puise - omm
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£

Fig 3.4.1 Tower design 1
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Fig 3.4.2 Tower design 2

The wind lens structure is designed by using the part
design in catia the steps involved in designing are:
> Initially select the plane for designing in
sketcher.
» Then
commands draw the structure of wind lens.

by using the profile tool bar

» By using the constrain tool bar the
dimensions for the design is given and the
dimensions are constrained.

» Then the body is moved to part design. The
lens is a circular structure so to design it
sketched based features tool bar is selected
and then the shaft command is selected.

» The axis for revolution is given as the
perpendicular line in plane and the rotation
is given for 360 degree. Thus the turbine is
designed

» The same procedure is followed for
designing different wind lens structures.

Fig 3.3.3 90 degree wind lens

Fig 3.3.4 100 degree wind lens and Fig 3.3.5 110
degree wind lens

Fig 3.3.6 120 degree wind lens
4.STATIC STRUCTURAL SETUP FOR TOWER
4.1 About structural analysis:Structural analysis is
probably the most common application of the Finite
Element Analysis. The term structural impels not
only civil engineering structures such as bridges and
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buildings, but also naval, aeronautical, and
mechanical structures such as ship hulls, aircraft
bodies, and machine housing, as well as mechanical
components such as pistons, machine parts and
tools.
Types of structural analysis:There are seven types
of structural analysis available in the ANSYS family of
products. The primary unknowns (nodal degrees of
freedom) calculated in a structural analysis are
displacements, other quantities ,such as strains,
stress, and reaction forces, are then derived from
the nodal displacement.

Structural analysis are available in the ANSYS Multi

physics, ANSYS Mechanical, ANSYS Structural and

ANSYS Professional programs only.

4.2 Importing The Geometry

1) Open ANSYS Workbench by going to Start >
ANSYS > Workbench.

As we are only doing a force loading, we will
be doing a Static Structural simulation. Load
the StaticStructural tool box by dragging and
dropping it into the Project Schematic.

2) To the left of the start up window, we have
analysis system. Load the Static Structural tool
box by dragging and dropping it into the Project
Schematic.

3) Save the file.

4) In the Project Schematic page, right click on
Geometry and import the file.

Here the structural analysis is performed on two
different blade designs and comparison is done on
the designs by using static analysis.

4.3 MESH GENERATION:Launch Mesher(Double
Click) Mesh

Generate the mesh by going to Mesh > Generate
Mesh

Then from the mesh controls select the mapped
face meshing and select the total domain and apply

on it. And generate mesh. Right click on Mesh and
insert Sizing

Fig 4.3.1 mesh sizing
Right click in the graphics window and click on Select
All. Change the Element Size. Right click on Mesh
and click on Generate Mesh. The meshed tower is
shown below:

Fig 4.3.2 meshed tower 1

0400

Fig 4.3.3 meshed tower 2
4.4 FIXED SUPPORT AND LOADS:To give the fixed
supports and loads, right click on static structural
analysis and go to insert and then select the fixed
support, force and pressure and apply them on the
body.
The applied forces are shown in the below figure:

Fig 4.4.1 loadings for tower 1
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Fig 4.4.2 loadings for tower2

5.CFD SETUP

Analysis Of WIND LENS and TOWER Using Ansys

Workbench:

5.1 ABOUT CFD:

Computational Fluid Dynamics (CFD) provides a

qualitative (and sometimes even quantitative)

prediction of fluid flows by means of

e Mathematical modelling (partial differential
equations)

e Numerical methods (discretization and solution
techniques)

e Software tools (solvers, pre- and post
processing utilities)

CFD enables scientists and engineers to perform

‘numerical experiments’ (l.e. computer simulations)

in a ‘virtual flow laboratory.

5.2 USES OF CFD:

Numerical simulations of fluid flow (will) enable

e Architects to design comfortable and safe living
environments

e Designers of vehicles to improve the
aerodynamic characteristics

e Chemical engineers to maximize the yield from
their equipment

e  Surgeons to cure arterial diseases
(computational hemodynamic)

e Meteorologists to forecast the weather and
warn of natural disasters

o Safety experts to reduce health risks from
radiation and other hazards

e Military organizations to develop weapons and
estimate the damage

e  CFD practitioners to make big bucks by selling

colourful pictures

120 Releases

Fig 5.2.1 Ansys logo
Definition: Model : A model is a mathematical
object that has the ability to predict the behaviour
of a real system under a set of defined operating
conditions and simplifying assumptions
The term modelling refers to the development of a
mathematical representation of a physical situation
WHAT IS MODELING?

* Modelling is the process of producing a
model.

* A model is a representation of the
construction and working of some system
of interest.

* A model is similar to but simpler than the
system it represents.

* One purpose of a model is to enable the
analyst to predict the effect of changes to
the system. Generally, a model intended for
a simulation study is a mathematical model
developed with the help of simulation
software.

¢  Mathematical model classifications include

e Deterministic (input and output variables
are fixed values) or

*  Stochastic (at least one of the input or
output variables is probabilistic);

e Static (time is not taken into account) or

¢ Dynamic (time-varying interactions among
variables are taken into account).

e Typically, simulation models are stochastic
and dynamic.

Definition: Simulation

Simulation is the process of exercising a
model for a particular instantiation of the system
and specific set of inputs in order to predict the
system response.Simulation refers to the procedure
of solving the equations that resulted from model
development

475 K.P.PREETHI MANOHARI SAl et al.,



International Journal of Engineering Research-Online

A Peer Reviewed International Journal
Email:editorijoer@gmail.com http://www.ijoer.in

Vol.4., Issue.3., 2016

(May-June)

WHAT IS SIMULATION?

A simulation of a system is the operation of
a model of the system.

The operation of the model can be studied,
and hence, properties concerning the
behaviour of the actual system or its
subsystem can be inferred.

In its broadest sense, simulation is a tool to
evaluate the performance of a system,
existing or proposed, under different
configurations of interest and over long
periods of real time.

Simulation is used

before an existing system is altered or a
new system built,

to reduce the chances of failure to meet
specifications,

to eliminate unforeseen bottlenecks,

to prevent under or over-utilization of
resources,

to optimize system performance.

How to select the best simulation software for an

application arises?

Metrics for evaluation include

476

Modelling flexibility

Ease of use

Modelling structure (hierarchical v/s flat;
object-oriented v/s nested)

Code reusability

Graphic user interface

Animation, dynamic business graphics,
hardware and software requirements
Statistical capabilities

Output reports and graphical plots
Customer support and documentation
Mathematical modelling - Aerospace
Applications

Using basic equations from dynamics,
mathematical equations are written that
describe how the vehicle will move in
response to forces that are applied to the
vehicle. For example, it is pretty easy to
describe how a rocket will accelerate when
a constant thrust is provided by the rocket's
engine.

*  Another type of modelling problem would
be to understand and predict, in a
mathematical equation, how an aircraft will
respond to hitting an updraft in the
atmosphere, or how the aircraft will
respond to the deflection of various control
surfaces at different airspeeds.

* An aerodynamic  subsystem  model
describes how the vehicle will respond to
forces caused by motion of the vehicle
through the atmosphere, and predicts the
effects of each different control surface
(such as the flaps, rudders, ailerons, etc.)
upon the motion of the vehicle.

* A propulsion subsystem model describes
how any motors or engines will behave and
what forces will act on the vehicle to which
they are attached.

* Alanding gear subsystem model is required
when the vehicle is in contact with the
ground in order to model how the ground
reaction forces are created and how they
affect the motion of the vehicle.

* An inertial properties subsystem model
provides details about how the mass and
inertia of the vehicle might change with
time.

* any electrical, mechanical, or electronic
system that assists the pilot in moving the
control surfaces has to be described
mathematically

The steps involved in developing a simulation model,
designing a simulation experiment, and performing
simulation analysis are:

Stepl. Identify the problem.

Step2. Formulate the problem.

Step3. Collect and process real system data.

Step4. Formulate and develop a model.

Step5. Validate the model.

Step6. Document model for future use.

Step7. Select appropriate experimental design.
Step8. Establish experimental conditions for runs.
Step9. Perform simulation runs.

Step10. Interpret and present results.

Step11. Recommend further course of action.
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5.3 Importing The Geometry
5) Open ANSYS Workbench by going to Start >
ANSYS > Workbench.

As we are only doing a fluent analysis, we will be
doing a cfd fluent simulation. Load the cfd fluent
tool box by dragging and dropping it into the Project
Schematic.

i s ] |
Fig 5.3.1 ANSYS Workbench Start Screen

6) To the left of the start up window, we have

analysis system. Load the Static Structural tool
box by dragging and dropping it into the Project
Schematic.

7) Save the file.

8) In the Project Schematic page, right click on
Geometry and import the file.

[
Se
Sqlda Oupicate
R Transfer Data FromNew >
s Transfer Data To New
7 Update

Reset
BE  Rename

Propertes

Quik Help

Fig 5.3.2 Importing Geometry
After importing and generating the geometry then
the enclosure is given for the body as a domain, and
Boolean operation is performed
Carry Out Boolean Operation: Subtraction
Create > Boolean. First,
set Operation to Subtract.
Select outer square domain as the Target Body
and the inner airfoil surface as the Tool Body.
Lastly, click Generate

0.000 000 (m) {L o
L S

0.500

Fig 5.3.3 Geometry and domain in cfd
5.4 MESH GENERATION:Launch Mesher(Double
Click) Mesh
Generate the mesh by going to Mesh > Generate
Mesh
Then from the mesh controls select the mapped
face meshing and select the total domain and apply
on it. The sizing is also given to the domain as 0.1
from the mesh controls and mesh is generated to
the domain.

Fig 5.4.1 meshed domain
Named Selections
To create named selections right click on the surface
and select Create Named Selection.
A dialogue box will appear where you will enter the
desired name of the boundary.

> Inlet
> Outlet
>  Walls

Fig 5.4.2 Named selections of domain
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6. SOFTWARE RESULTS AND DISCUSSION
Solution in Structural Analysis:
6.1 Deformation
To add deformation to the solution, first

click E- Solution (B5) t5 add the solution

sub menu to menu bar. Now in the solution sub
menu click Deformation > Total to add the total
deformation to the solution. It should appear in the

outline tree.

0.300 (M)
01460

Figb.1.1 Tower 1 deformation

0.200 (m)

0.100

Fig6.1.2 Tower2 deformation
In the solution sub menu, selectStress > Equivalent

(von-Mises).In the details pane, ensureGeometryis
set toAll Bodies

i
0.300 (m) 2

0150

Fig 6.1.3 von-mises stress for tower 1

0.200 (m)

0,100

Fig 6.1.4 von-mises for tower2

In the solution sub menu, select Stain > normal. And
solve the geometry

6.1062e-7
4.9892e-7
3.8722e-7
2.7551e-7 Min

o
0.000 0.300 (m) =
L E—

0.150

Fig 6.1.5 Equivalent elastic strain for tower 1

5.26580.7
2.80980.7 Min

70 X

0.200 (m) L v

0.100

Fig 6.1.6 Equivalent elastic strain for tower 2
In the solution sub menu, select stress > maximum

shear stress

z

X
0200 ¢} \L.
—

0160

Fig minimum principal stress for tower 2

6.2 Setup and Solution in FLUENT:

In Ansys workbench double click Setup to open

FLUENT.

Before FLUENT launches, In Options check the box

next to Double Precision

Now the Fluent window is open and the mesh has

imported into the fluent solver.

Problem setup:

» General>Type as: Pressure based

» Models>Energy OFF-> Select Viscous-laminar

> Materials>Air->Create/Edit—=>Set

» Boundary conditions>Select inlet> Give type
as:velocity-inlet>Edit> Set 20 m/s—>ok
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» Problem Setup—>Reference Value->Compute
from : Inlet

Solution:

» Select the monitors and change convergence
criteria to 10”-6.

» Solution
inlet>Initialize

initialization>Compute from:

» Run calculations—>Enter the no. of iterations as:
1000->Calculate

By using the cfd post results are noted, in cfd post

the stream lines are taken and a plane is set

perpendicular to the body for easy flow from the

body and the results are obtained as.

74

12

Velocit
Streamiine 1
. 3.247e+001

2.436e+001
‘ © 1.624e+001

811984000 ]
. |
|
0.000e+000 5!

[mst1]

0 0250 0500 (m)
— e «
0125 0375

fig 6.2.1 90 degree wind lens
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Velocit NN
Streamiine 1

F 2.915e+001
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7.287e+000 .
= i

[m s~-1)

— B _omm 2
Fig 6.2.2 100 degree wind lens

Velocit

reamiine 1
F 2.7450+001

2.058e+001
| 1.372e+001
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Fig 6.2.3 110 degree wind lens
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Fig 6.2.4 120 degree wind lens
The results are compared for all the wind lens and it
is observed that in between the 90 — 100 degree the
velocity is increased, so a wind lens for 96 degree is
created and flow analysis is performed on it and the
results are

AN & |

2.0900+001
1.0456+001

™ 0.0006+000
(m s7-1)
i

|
|
|

ey, !
fig 6.2.5 96 degree wind lens
So the results are concluded as the 96 degree wind
lens gives better result.
7. EXPERIMENTAL SETUP AND RESULTS
To run the experimental setup primarily the things
required are:

»  Wind turbine blades

» Generator (dynamo)

> Tower

» Wind lens
The power available by running the dynamo helps us
in finding the efficiency of the design , the dynamo is
connected to the propeller so that when the
propeller rotates the shaft of the dynamo rotates to
generate power.
7.1 Wind turbine blades and Dynamo:
The turbine blades are designed in the designing
procedure, the manufacturing of the blades is
observed to be a difficult task so the blades which
are similar to the designed blades with a scaled size
is bought and used for experiment purpose.
The dynamo which helps in converting the
mechanical energy in to electric current is used in
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the experimental procedure which has a maximum
output of 12v

Fig 7.1.1 propeller and dynamo
Tower is used in this experimental setup to attach
the dynamo so that the fluid passing can move easily
on the propeller blades.

7.2 WIND LENS:A wind lens is a modification made
to a wind turbine to make it a more efficient way to
capture wind energy. The modification is a ring
structure called a "brim" or "wind lens" which
surrounds the blades, diverting air away from the
exhaust outflow behind the blades. The efficiency of
the turbine blades is increased by increasing the
velocity of flow on the blades.

7.3 Manufacturing dimensions of wind lens:The
wind lens is a divergent duct section with circular
cross-section, the dimensions for manufacturing are
made on basing the propeller blades dimensions.
Table 3: Dimensions of wind lens

Propeller
blades 23cm
(diameter)

Inlet of wind
lens 24cm
(diameter)
Outlet of

wind lens 28cm

(diameter)
Width of

wind lens 10cm
(length)
The wind lens is manufactured by using this

dimensions and a circular obstacle is made at the
end of the duct for yawing and for creating low
pressure purpose.

The manufacturing of wind lens is made by
using the Gl sheet. As it can be flexibly bended and
used so for the trail procedure this material is used.

7.4 Manufacturing procedure:

» Primarily the dimensions are marked for the
wind lens on the GI sheet. For the dimensions
the circumference of the inlet and outlet are
used so that when they are closed a circular
section is obtained with the given

circumference and the diameter.

Circumference 75.36cm
of inlet
Circumference 87.92cm

of outlet

Fig 7.4.1 dimensions of wind lens

» The dimensions are marked on the Gl sheet and
the extra material is removed.

» Now by using the spot welding procedure the
sheet is made into circular shape and joined.

» Now two circles are drawn on the Gl sheet as
shown in figure so that it can be attached at the
outlet.

Fig 7.4.2 circular cross section diameters
» This circular cross section is spot welded with
the convergent duct at its outlet section, thus
the required wind lens is manufactured.

Fig 7.4.3 wind lens
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7.5 Experiment procedure:
+ The propeller attached to a dynamo is
fitted on a tower for the height to run the

experiment.

Fig 7.5.1 tower with the propeller

+» The power is calculated when the propeller
is freely rotated, then the wind lens is kept
around the turbine blades so that it acts as
a diffuser section and then the power is
noted and the RPM (revolutions per
minute) are verified.

Fig7.5.2 wind lens turbine
7.6 RESULTS
» The results are noted for the UPWIND and
DOWN WIND turbine. It is found that the
efficiency of the down wind turbine is observed
to be better than up wind.

W Fitting 0u:t to parimeter of W Croats strong votices, then BWind 5 suckac to lower
{1 0 D00 Yo OS50 bt (OB 1) 400 ) 50}
1 fusting In tna duct fa neraasod by

13- 15 s

(May-June)
Specification | UP WIND DOWN
WIND
Without 3volts 3volts
wind lens
With wind | 6.5 / 7 | 8volts
lens volts

» The results may vary with the change in the
velocity of the wind.
CONCLUSION
» Wind turbines helps in converting mechanical
energy into electrical energy to improve this
efficiency or the amount of obtained current
the concept of wind lens is used and the
results prove the increase in efficiency.

» Analysis on the tower is performed to know
the structural changes to be used in
constructing the tower.

» The diameters of the foundation and the
tower and the varying height all play a vital
role in the strength of the tower

» The concept of WIND LENS is used to
improve the velocity of wind on the blades,
it is also used to create a low pressure
region in the front of the flow so that the
air moves fast into the region so the turbine
blades rotate with high RPM.

Low-pressusre region due
to strong vortices spWind

flows into this region

e The amount of power may change depending
on the velocity of the flow, and the length of
the turbine blades cause more moment so that
it keeps it revolving maximum time, so the
length and design of blades play a major role in
power generation.
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